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1 
Introducing SCORBASE 

SCORBASE for SCORBOT-ER 2u/4u is a robotics control software package 
for robot programming and operation. SCORBASE for SCORBOT-ER 2u/4u 
provides numerous capabilities: 
• Communication with the robot controller over USB channel. 
• Control and real-time status display of five robot axes, gripper and two 

peripheral axes. 
• Full support and real-time status display of eight digital inputs, eight digital 

outputs, two analog outputs and four analog inputs. 
• Position definition and display as well as manual robot movement in joint 

coordinates (encoder units).  
• Cartesian coordinates (X,Y,Z Pitch and Roll) are also available. 
• Robot movement definition as Joint, Linear, or Circular, with ten active 

speed settings. (Availability depends on level.) 
• Default setting of 1000 positions and 1000 active program lines. 
• Interrupt programming for handling responses to changes in digital input 

status. 
• Variable programming, in three levels of complexity, to moderate the 

learning curve. This makes it possible for beginners to start at a lower level, 
and advance through the levels, as they become more skilled in robotics 
programming. 

• Saving and loading projects. 
• SCORBASE can be installed as part of RoboCell, an interactive graphic 

software package, which provides simulation of the robot and other devices 
in the workcell. 

This manual describes all the features and operations for all levels of 
SCORBASE. When necessary, illustrations show the differences in the levels, 
and descriptions note the availability of options and commands. 
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2 
Starting SCORBASE 

The instructions in this chapter are for SCORBASE only.  

If you intend to install SCORBASE as part of the RoboCell software package, 
follow the instructions in Chapter 2, Starting RoboCell, in the RoboCell User 
Manual. 

System Requirements 

SCORBASE for ER 4u computer requirements are: 
• Pentium III with 450 MHz processor, or higher, equipped with CD drive. 
• At least 128 MB of RAM. 
• A hard drive with at least 60 MB of free disk space. 
• Windows 98/2000/me/xp. 
• A Super VGA or better graphics display, minimum 256 colors. 
• A Mouse or other pointing device. 
• USB port. 

Installing the Software 

The SCORBASE software is supplied on a CD which also contains RoboCell. 
Close any open applications before proceeding with the installation procedures. 
If you are about to reinstall the software, or install a newer version to an 
existing SCORBASE directory, it is recommended that you back up any 
existing user-created files before you begin the installation. It is also 
recommended that you remove the previous SCORBASE version for Windows 
installation, using the software’s Uninstall utility.  
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To install SCORBASE: 
• Insert the CD into the CD-ROM drive to start the installation procedure. 
• If the procedure does not start, either: 
• From the Windows task bar, click Start | Run and type D:Setup  

(where D: is your CD drive),  

or  
• Using Windows Explorer, explore the CD drive and  

click  Setup. 
• Wait until the Welcome window is displayed. 

 

Figure 2-1: Welcome Window 
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• Click Next to open the Software Selection Window. 

 

Figure 2-2: Software Selection Window 

• Select RoboCell for ER 2u, RoboCell for ER 4u, SCORBASE for ER 2u or 
SCORBASE for ER 4u. The robot that you select becomes the default 
robot while you are working in SCORBASE, although you can choose to 
open a new project and work with the other robot. See the Hardware Setup 
option in the Options Menu. 
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• Click Next to open the License Agreement Window. 

 

Figure 2-3: License Agreement Window 

• Review the Intelitek software license agreement. You must accept the 
terms of this agreement in order to proceed with the installation. To accept, 
choose Yes. The Choose Destination window opens. 

 

Figure 2-4: Choose Destination Window 
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• The default destination folder for the files is: 
\Program Files\Intelitek\SCORBASE 
Click Next to accept the default, or click Browse to select another folder 
and then click Next to open the Select Program Folder window.  

 

Figure 2-5: Select Program Folder Window 

• In the Select Program Folder window you are requested to select the folder 
to which the program icons will be added. 

• Click Next to complete the installation procedure. 

Uninstalling the Software 

To uninstall SCORBASE: 
1. From the RoboCell program group, select Uninstall. 
2. Follow the instructions which appear on the screen. 

Starting SCORBASE 

The following procedure describes how to access the SCORBASE for ER 4u 
application. However, the same procedure applies to SCORBASE for ER 2u.  

To start SCORBASE: 
1. Make sure that all the components to be used are installed and 

connected according to the installation procedures detailed in the User 
Manuals supplied with the robot and controller. 

2. Turn on the computer and the controller. 
3. Select Start | Programs | SCORBASE for ER 4u. 
4. Select the SCORBASE for ER 4u command. After initialization, the 

following screen appears: 
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Figure 2-6: SCORBASE Opening Screen 

If SCORBASE opens in On-line mode, the controller is detected and this 
message appears: 

 
Select OK to select Control On (CON) state. Select Cancel to remain in 
Control Off state. 

If SCORBASE opens in Off-line mode or the controller is not detected, the 
program will load and operate in Off-line mode.  

Only one application of SCORBASE can be active at a time. 

Quitting the Software 

Stop the SCORBASE program (if running). If you have unsaved changes in the 
project, SCORBASE prompts you to save the changes before closing. 

To close SCORBASE (or its components), do any of the following: 
• From the Menu Bar, select File | Exit. 
• Click the Close box in the SCORBASE Title Bar. 
• Press [Alt]+F4. 
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3 
Menus Overview 

The SCORBASE Window 

Figure 3-1 shows the SCORBASE opening screen which comprises: 
• A Title Bar containing the screen name and the usual Windows controls for 

sizing and closing the application screen.    
• A Menu Bar containing all SCORBASE command menus and options. 
• A Toolbar containing icons for the most commonly used options.  
• A Status Bar displaying information regarding the SCORBASE software, 

modes of operation, current activity, etc. When you position the mouse 
over an icon, a description of the icon appears in the status bar. 

Note: In version 4.9.1 the System menu (displayed by right clicking the Title 
Bar) contains the Always on Top menu item, enabling you to display the 
application on top at all times. 

Title Bar 
Menu Bar 
Toolbar 
 
 
 
 
 
Status Bar 

 

Figure 3-1: SCORBASE Window 
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File Menu 

A SCORBASE project contains a program (SBP file), user-defined positions 
(PNT file), and a project data file (WS file). If RoboCell is also being used, the 
project includes the cell image (3DC file). Throughout this manual, the term 
“project” refers to the program positions (and image) files saved by the user as 
one entity. 

 
The File menu contains the usual Windows functions that allow you to 
open new or previously saved projects, save and close projects. You can 
print files containing robot programs and positions, and exit the software. 
 
 
 
 
 
The File menu options are: 

 
New Project (Ctrl+N) Opens a new, untitled, project.  

 
Open Project (Ctrl+O) 

 

Opens the Load Project window which lists 
SCORBASE files (without a virtual cell). 

 
Save Project (Ctrl+S) 

 

Saves the currently active project (program, 
positions and graphics). 

 Save Project As... Saves the currently active project under a new 
project name. 

 Close Project Closes the currently open project. 

 Print Program Prints the program. (Program window must be 
active). 

 Print Positions Prints the user-defined positions. (Positions 
window must be active) 

 Print 3D Image Reserved for RoboCell program option. 

 Print Preview  
3D Image 

Reserved for RoboCell program option. 
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 Print Charts Opens a dialog box to select the specific 
axis chart for display or printout. Only one 
axis can be selected at a time. 

 Print Preview Charts Displays the selected axis chart before 
printout. 

 Import 3D Model Reserved for RoboCell program option. 

 Edit 3D Model Reserved for RoboCell program option. 

 View File Enables you to view a file from those listed: 
• Graphic module files (*.3DC) 
• SCORBASE programs (*.sbp) 
• Position data (*.pnt) 
When you select a file, a window opens 
displaying that file. 

 Exit Closes SCORBASE. If changes to a 
program or position file have been made 
but not yet saved, a message appears giving 
you the opportunity to save the file before 
you exit SCORBASE. 

For more information on SCORBASE File Management, see Chapter 9. 

Edit Menu 

The Edit menu contains the usual Windows functions that allow you 
to edit program files. 

Cut (Ctrl+X) 

 

Deletes selected text or lines from the program 
lines, and places it on the Windows and 
SCORBASE clipboards. 

 Copy (Ctrl+C) 

 

Places a copy of selected text or lines from the 
program lines on the Windows and 
SCORBASE clipboards. 

 Paste (Ctrl+V) 

 

Inserts the contents of the SCORBASE 
clipboard into the program lines. 

 Find (Ctrl+F) 

 

Opens a dialog box that allows you to search 
for a particular text string, SCORBASE 
command, or command argument. 

 Find Next Repeats the last Find operation for the next 
occurrence. 
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 Command/Remark 
(*…) (Ctrl+R) 

 

Inserts/deletes asterisk at beginning of a 
SCORBASE program command line. This 
action toggles the command line between a 
remark and an executable command. 

 Go to Line Opens a dialog box that displays the total 
number of lines in the program, and prompts 
you for a line number. The program editor 
jumps to the line you specify. 

 Edit Line Edit a selected line. Useful for long programs. 

For more information on these and additional SCORBASE editing functions, 
see Chapter 6. 

Run Menu 

 
The Run menu contains SCORBASE commands for homing the robot 
and peripheral axes (see Chapter 4, Homing and Control), and executing 
programs. 
 
Note: If the software is operating Off-line, only the Run program options 
are available in this menu. 

 
Search home - 
all axes 

Homes both the robot and any configured 
peripheral axes. 

 Search home – 
robot 

Homes the robot. 

This command is available only if the system 
has been homed once, after opening 
SCORBASE. 

 Search home – 
peripheral  

Homes the peripheral. 

This command is available only if the system 
has been homed once, after opening 
SCORBASE. 

 
Run single line (F6) Executes the selected (highlighted) program 

line. 
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Run single cycle 
(F7) 

Executes the program from the selected 
(highlighted) program line to the end of the 
program. 

 
Run continuously 
(F8) 

Executes the program from the selected 
(highlighted) program line. When the last 
program line is reached, the program starts 
again from the first line. 

 Go home – all axes Sends the robot and peripherals to their home 
positions. 

This command does not home the system. 

 Go home - robot Sends the robot to its home position. 

This command does not home the robot. 

 Go home – 
peripheral  

Sends the peripherals to their home position. 

This command does not home the peripherals. 

 
Pause (F10) Stops program execution after the current line is 

executed. 

 
Stop (F9) Immediately stops program execution and 

movement of all axes.  

 Note: Pause and Stop are software methods for halting program 
execution. In an actual emergency situation, you should use the 
EMERGENCY button on the controller or the ABORT key on the 
Teach Pendant. 

For more information on SCORBASE Setup Options, see Chapter 10. 

For more information on Program Execution, see Chapter 8. 

Options Menu 
 
The Options menu allows you to define your preferences for operating 
the software.  

On-Line Establishes communication with the controller. 

 
Off-line SCORBASE does not communicate with the 

controller, even though it may be connected.  

Off-line mode is useful for checking and 
debugging programs. 
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Control On (F5) Enables servo control of the axes and I/O 

device. 

 
Control Off Disables servo control of the axes and 

communication with I/O device.  

 Hardware Setup Opens the Hardware Setup dialog box where 
you can define the peripheral devices which are 
connected and operated by the controller as 
axes 7 and 8. Full details are provided in 
Hardware Setup in Chapter 10, System Setup. 

 

Figure 3-2: Hardware Setup Dialog Box 
showing default settings 

The Hardware Setup option also enables you to 
work with a robot different from the one you 
selected during installation (see Installing the 
Software above). To do so, click Robot. 

 
Select the desired robot and click OK. 

 Set Parameters Opens the Parameter Set window (see Figures 
3-3 and 3-4). You have to activate the 
Advanced Commands before can you utilize 
Set Parameters (see the Advanced Options 
option below). 
Parameters can be set for the robot and for each 
one of the eight axes. Select the appropriate tab 
and set the desired parameters. 

 Line Number Shows/hides program line numbers in the 
program window. 
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 Reload last project at 
startup 

When checked, opens the last project saved 
when SCORBASE is started. 

 
Level 1 Displays list of commands and options at 

introductory level. Commands related to Levels 
2 and 3 are disabled. 

 
Level 2 Displays list of commands and options at 

advanced level. Commands related to Pro are 
disabled. 

 
Pro Displays list of all commands and options. 

 Advanced Options Opens a dialog box in which these options are 
available: 
• Advanced Commands (see Chapter 6, 

Program Editing). 
• ViewFlex Commands (see the ViewFlex 

User Manual). 

 
When one or both options are checked, the 
corresponding commands (Advanced 
Commands and Vision Commands) are listed 
under the Command tab of the Workspace 
window. 
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Parameter Set Windows 

 

Figure 3-3: Parameter Set Window - for Robot 

 

Figure 3-4: Parameter Set Window - for Axes 
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SCORBASE contains the following parameter sets: 

Parameter Set Description 

$2KG Moves objects that weigh about 2 kg. 
$3KG Moves objects that weigh about 3 kg. 
$Current Current parameter set loaded to the controller. 
$Default Default set when parameters are optimized. 
Maxspeed Activates the robot at maximum speed. 

To modify any of the parameters of the above vendor supplied sets you must 
save the set under a different name. Click the Save As icon to open the dialog 
box. Enter the name of the new Parameter Set and click OK to save it. 

Use the Parameter Set window tool bar to select one of the following options: 

 
Open Displays the Open Parameter Set window. Select 

the desired Parameter Set from the list. 

 
Save Saves the Parameter Set after changes have been 

affected. 
A Parameter Set marked with the $ symbol cannot 
be changed and saved. The set must first be saved 
under a new name using the Save As icon. 

 
Save As Opens the Save Parameters Set As dialog box. 

Enter the name of the new Parameter Set and click 
OK to save it. 

 
Default Displays the $Default Parameter Set. 

 
Apply Loads the selected Parameter Set to the controller. 

 
View Opens the selected Parameter Set Window which 

lists all the parameter keys, with description and 
value, included in the Parameter Set. The keys are 
listed by sections (see Figures 3-2 and 3-3). 

 

For more information on SCORBASE Setup Options, see Chapter 10. 



 

SCORBASE  18 User Manual 
0311   Menus Overview 

View Menu  

The options in the View menu allow you to show/hide SCORBASE 
dialog bars and windows. 

Workspace Shows/hides the Workspace window. Through 
this window, the user can access the project files 
and the SCORBASE commands tree (see Chapter 
6, Program Editing). 

Manual Movement Shows/hides the Manual Movement dialog box. 
This box enables manual control over the 
movements of the robot, the gripper and 
peripheral axes. 

Teach Positions Shows/hides the Teach Position dialog box. This 
box enables recording, teaching and deleting 
positions. It also enables the user to send the robot 
and/or peripherals to a previously defined 
position.  

Robot Movements Opens a dialog box that displays the robot axes. 
Pressing on a selected axis moves it in the 
selected direction. 

List Position The List Positions window displays the positions 
of the currently open project. The list is presented 
in tabular format. 

 

Charts Opens Charts window. See Charts later in this 
chapter. 
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 Dialog Bars Toggles the display of seven dialog bars that 
enable the following: 
• Joints – Displays the robot’s joints angle 

(five joints). 
• XYZ - Displays the robot tool center point 

(TCP) position and orientation. The 
coordinate system origin is at the center of 
the robot base at table level. 

• Digital outputs - Displays the status of 
digital outputs 1-8 (dark green - off; light 
green - on).  Click on an output to 
show/hide its status. 

• Digital inputs - Displays the status of 
digital inputs 1-8 (dark green - off; light 
green - on).  In Off-line clicking on input 
toggles its status. 

• Analog outputs - Displays the value of 
analog output 1&2 (0-255)-(0-10 volt). 

• Analog inputs - Displays the value of 
analog input 1-4 (0-255). In Off-line you 
may set the analog input value. 

• Encoders – Displays the encoder counts of 
axes 1-8. (Encoders are zeroed after 
homing the system.) 

Show All Dialog Bars Displays all seven dialog bars. 

Close All Dialog Bars Closes all seven dialog bars 

Movement 
Information 

Displays the following data: 
• Position error of eight axes in encoder 

counts 
• Home switch status of all eight axes 
• PWM for one selected axis. The PWM 

(Pulse Width Modulation) is the controller 
output for the selected axis motor. 

Messages Opens the Messages window. 

The data printed in the Messages window is printed 
using the PS (Print to Screen & Log) command. 

Toolbar Shows/hides the programming toolbar (default on). 

 

Status Bar Shows/hides the lower status bar (default on). 
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Window Menu 

 

The Window menu enables you to select the desired window display. 

Simulation & Teach Sets the screen to display the RoboCell window 
and dialog bars required to define positions. 

Teach & Edit Opens Teach position, Manual movement, 
Program and Workspace windows. 

Run Screen Displays the dialog boxes and menus used for 
program execution. 

Project Screen Displays the Program and Positions of the 
Project. 

[Project Name] Displays the Project name of a program which 
is running. 

Help Menu 

The Help menu options:  

SCORBASE Help (F1) Opens SCORBASE on-line help. 

 About Shows the SCORBASE software version.  
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Charts 

SCORBASE charts can be configured to display the following data (Y-axis) 
vs. time (X-axis). 
• Encoder counts (axis position), represent the actual axis position. The 

encoder counts are shown in a blue line. 
• Position error is the difference between the required axis position and the 

actual axis position. The error is expressed in encoder counts and shown in 
a red line. 

• The PWM value represents the controller output. The error and the axis 
control parameters determine the PWM value shown in a green line. 

Each axis data (1-8) is shown in a different chart. Sample charts for axes 1 and 
2 are shown in Figure 3-5. 

 

Figure 3-5: Chart for Two Axes 

To open the Charts window, do one of the following: 

• Click the Charts icon in the toolbar . 
• Select View | Charts. 
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The following options are available in the Charts window toolbar: 

 
Start chart Starts drawing the chart. 

 
Stop chart Stops drawing the chart. 

 

Options Opens the Chart Options dialog box where you can select 
the data to be displayed in the chart(s).  

 

Figure 3-7: Chart Options Dialog Box 

Click the data that you want displayed in the charts.  
The example shown in Figure 3-4 results in the display of 
the Encoder, Error and PWM of axis 1, as well as the 
display of the Encoder and Error for axes 2 through 6. 
Since each axis is shown in a different chart, six charts will 
be displayed. 

Any chart can be saved to a history (*.his) file. To do so: 
• Check the Record History box. 
• Click the Browse button (which becomes available) 

to open the window.  
• Select the folder and enter the name of the file to be 

saved. 
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To set the resolution of the chart for the Encoder, Errors 
and PWM: 
• Click the Advanced button in the Chart Options 

dialog box. The Range column opens. 

 

 

History Opens the History Files Window (see Figure 3-5). Select 
the desired history (*.his) file from the list or browse to 
locate it.  
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Figure 3-8: History Files Window 

Note: To open a history file you must first stop drawing the 
chart. 

 

Legend Displays the colors used in the charts for Encoder, Error 
and PWM. 

Encoders – Blue 
Error – Red 
PWM – Green 

 

 

 



 

User Manual  25 SCORBASE 
0311   Homing and Control 

4 
Homing and Control 

General 

The robot and peripheral axes location is monitored and controlled using 
encoders. To initialize the encoders and to obtain repeatable performance the 
axes must first reach a predefined position known as hard home. All recorded 
positions and movements refer to the hard home position. The homing 
procedure finds the hard home for the selected axes. 

SCORBASE offers two commands relating to the home position. 
• Search Home starts the homing procedure. During Search Home each axis 

is homed separately. The controller activates the currently homed motor 
axis, until its micro-switch is pressed. Then the controller initializes the 
axis encoder counter and turns to home the next axis. After all configured 
axes are homed, the homing procedure ends. 

• Go Home sends the selected axes to a position where the encoders’ value is 
zero. Note: This command does not home the axes. 

The two commands are available in three levels: 
• Search / Go home all (applies for all active axes) 
• Search / Go home robot (applies for the robot) 
• Search / Go home peripherals (applies for axes 7 & 8). 
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Search Home Command  

All Axes 
To start the homing procedure, do one of the following: 
• Select Run | Search home - all axes. 

• Click the Search Home  icon. 

A window opens displaying the number of the axis currently being homed. 
Each time an axis is successfully homed, a checkmark appears next to the axis 
number. After the five axes and the gripper have been homed, a checkmark 
appears next to Robot. 

 
To abort homing while the procedure is still in progress, do one of the 
following: 
• Press F9 (Stop command)  
• Press the red EMERGENCY button on the controller. 
• Press the EMERGENCY key on the Teach Pendant. 

If the homing procedure fails, a message appears. 

The Search Home - All Axes command executes the robot’s homing procedure 
as well as that of any peripheral devices that have been configured in the 
Options | Peripherals Setup menu. The command is available only when 
SCORBASE is On-line for the first time. 

If the system has already been homed and you change SCORBASE to Off-line 
mode, there is no need to home the system again when you return to On-line 
mode. 

When SCORBASE is Off-line, or when RoboCell is installed, the homing 
procedure is not required, although it can be executed. The homing procedure 
initializes Joint and XYZ values according to a software definition. All 
encoders are set to 0, while the robot Cartesian coordinates are set according to 
a software model. 
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Search Home - Robot 
This command runs the homing procedure for the robot. 

Homing of the peripherals is enabled only after the system has been homed 
once. 

Search Home - Peripherals 
This command runs the homing procedure for the configured peripherals. 

Homing of the robot is enabled only after the system has been homed once. 

Go Home Command 

All Axes – Robot – Peripherals 
After the axes have been homed, select Run | Go Home - All Axes to send the 
axes back to their home position at any time. This command sends the robot 
and peripherals to a position where the axes encoders value equals zero. The 
Go Home command does not run the homing procedure. 

Selecting the Go Home - Robot or Go Home - Peripherals command sends the 
selected axis to its home position. 

On-line / Off-line Modes 

SCORBASE can run either in On-line or in Off-line mode. In On-line mode, 
SCORBASE communicates with the controller over the USB channel. If the 
Control On state is selected, SCORBASE controls the robot, peripherals and 
I/O device. In Off-line mode, SCORBASE can be used only in the Control Off 
state (useful for programming and debugging). The active mode is displayed in 
the status bar. 

To change to On-line, select Options | On-line. 

To change to Off-line, select Options | Off-line. 

If SCORBASE is opened in On-line, or On-line is selected from the Options 
menu, this message appears as SCORBASE searches for the controller: 

 
If the controller is detected, On-line mode is activated. 

If the controller is not detected, Off-line remains the active mode. 
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Control On / Control Off – CON/COFF 

The Control On state enables servo control of the axes and I/O device. This 
state is available only in On-line mode. In the Control Off state, axis movement 
commands cannot be executed. The Control state (On or Off) is displayed in 
the lower right corner of the status bar. 

To enable control of the axes, do one of the following: 
• Select Option | Control On. 

• Click the Control On icon . 
• Press the F5 key. 

To disable control, do one of the following: 
• Select Option | Control Off. 

• Click the Control Off icon . 

If you have disabled control and SCORBASE opens in On-line mode, or On-
line mode is selected after detection of the controller, this prompt appears: 

 
Press OK to enable control or press Cancel to remain in the Control Off state. 

The controller automatically disables control if an impact condition, trajectory 
error or thermic overload error occurs during execution of a movement 
command. If you attempt to move the axes when control is disabled, this error 
message appears: 

 
When SCORBASE is in Off-line mode, the Control On/Off state cannot be 
altered. 
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5 
Position Definition 

Every SCORBASE project includes a set of pre-defined positions and a 
program that sends the robot from one position to the other. Prior to running a 
program all the positions used in that program should be defined. SCORBASE 
offers various tools to define and store positions that will be used in the 
programs.  

The following SCORBASE tools are used in the position definition process. 
• Manual Movement dialog box 
• Teach Positions (simple or expand) 
• Robot movement dialog box 
• Position data dialog bars 
• Position window 

To activate the dialog boxes which are most useful for position definition, 
select Window | Teach & Edit. 

Any of the following four methods can be used for position definition:  

No. Method Level 

1 Absolute position Joint coordinates 1, 2, Pro 
2 Relative position Joint coordinates 2, Pro 
3 Absolute position Cartesian coordinates 2, Pro 
4 Relative position Cartesian coordinates 2, Pro 

Note: Peripheral position definition can only be performed in the Pro level.  
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Joint and Cartesian Coordinate 
Systems 

Defining a position in SCORBASE can be done by using either the Joint or 
Cartesian coordinate systems. In both systems, a robot position is defined using 
five parameters derived from the data supplied by the five axes encoders. An 
encoder is an angular movement sensor attached to the axes motor. 

A Peripheral position is always defined using one variable that stores the sensor 
output (encoder value) of that position.  

Joint Coordinate System 
A robot position in Joint coordinates is defined by five angle values, 
representing each angle of the joints. The joint names are Base, Shoulder, 
Elbow, Pitch, and Roll.  

 
Figure 5-1: Robot Joints 
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For example after homing, the robot position in Joints coordinates is: 

Axis #1 - Base = (0°) 

Axis #2 - Shoulder = (–120°) 

Axis #3 - Elbow = (∼95°) 

Axis #4 - Pitch = (∼88°) 

Axis #5 - Roll = (0°) 

Cartesian (XYZ) Coordinate System 
A robot position in Cartesian (or XYZ) coordinates is defined by these 
parameters.   
• The distance of the robot’s Tool Center Point (TCP) from the point of 

origin (the center bottom of the robot base), along the three axes that 
describe three-dimensional space (X,Y,Z). 

• The Pitch and Roll angles of the gripper, specified in angular units. 

 
Figure 5-2: XYZ 
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For example after homing, the robot position in Cartesian coordinates is 
defined as: 

X = (∼169) [mm] 

Y = (0) [mm] 

Z = (∼503) [mm] 

Pitch = (∼-63°) 

Roll = (0°) 

A position recorded in one coordinate system can be converted by 
SCORBASE to another coordinate system. 

Absolute and Relative Positions 

SCORBASE offers two methods of defining a robot or peripheral position: 
Absolute and Relative. The two methods are applicable in Cartesian and in 
Joint coordinates.  

An absolute position is defined using all five robot position parameters. If the 
Joint coordinate system is used, the robot position is defined using the Base, 
Shoulder, Elbow, Pitch, and Roll angles. In the XYZ coordinate system, a 
position is defined using the X, Y, Z values in millimeters, and the Pitch and 
Roll angles in degrees. An absolute position is usually a fixed position in world 
space. 

A relative position is a position whose coordinates are defined as an offset 
from a reference position coordinates. If the coordinates of the reference 
position change, the relative position moves along with it, maintaining the 
same offset. A relative position can be defined in either Cartesian or Joint 
coordinate values. 

A position can also be defined as relative to current. In this case, the relative 
position is calculated as an offset from the coordinates of the current robot 
position. 

Record and Teach 

Although the terms teach and record are often used interchangeably, 
SCORBASE makes the following distinction: 

Record position: defines a robot position in a Joint coordinates system.  

Teach position: defines a robot position in a Cartesian coordinates system. 
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Manual Movement Dialog Box 

Recording a robot position (in Joint coordinates) is done by manipulating the 
robot to the required position and then recording it. The Manual Movement 
dialog box allows direct control and manipulation of the robot and peripheral 
axes.  

The Manual Movement dialog box is automatically opened when a project is 
opened, or when the Window | Teach & Edit display setting is selected. 

To open the Manual Movement dialog box when there is no open project, 
select View | Manual Movement. 

 
 

Figure 5-3: Manual Movement Dialog Box (SCORBOT ER-4U) 

 
Figure 5-4: Manual Movement Dialog Box (SCORBOT ER-2U) 

Note: Axis 6 is not applicable in SCORBOT-ER 2u. 
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The following chart explains how clicking the buttons in the Manual 
Movement dialog box (or pressing the corresponding keys on the keyboard) 
controls the robot and peripheral movements. 
Joints When Joints is selected, clicking the buttons (or pressing 

the corresponding keys on the keyboard) moves one 
robot axis at a time, as described below: 

 Keys Joint Motion 

 1 / Q Rotates the BASE right and left. 

 2 / W Moves the SHOULDER up and down. 

 3 / E Moves the ELBOW up and down. 

 4 / R Moves the wrist (PITCH) up and down.  

 5 / T Rotates the wrist (ROLL) right and left. 

 6 / Y Opens and closes gripper via servo control. 

 7 / U Moves peripheral axis #7 (if connected).  

 8 / I Moves peripheral axis #8 (if connected). 
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XYZ 

 
When XYZ is selected, clicking the buttons (or pressing the 
corresponding keys on the keyboard) moves the TCP, as 
described below. 
Movements in XYZ mode are sometimes a combination of 
simultaneous movements of a few axes. 

 Keys XYZ Motion 

 1 / Q TCP moves along X-axis (back and forth). 
 2 / W TCP moves along Y-axis (right and left). 
 3 / E TCP moves along Z-axis (up and down). 
 4 / R Axes move in order to change the gripper’s 

pitch angle; the TCP position does not change. 
 5 / T The gripper rolls; the TCP position does not 

change. 
 

  

Open Gripper Completely opens the gripper.  

 

Close Gripper Completely closes the gripper. 

 

Go to position Goes to the Go to Position command. Sends the 
axes to the selected position. 

 

Go Linear to position Goes to Go Linear to Position command. 

The robot can be manipulated from the Manual Movement dialog box before it 
has been homed in Joint mode only. In fact, it is often necessary to bring the 
robot into a more suitable position before initiating the homing routine. 
However, an axis limit error message may appear during manipulation of a 
robot that has not been homed. 

Movement of an axis continues as long as the button or key is pressed, or until 
a software or hardware limit is reached. 
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Robot Movement Dialog Box 

The Robot Movement dialog box enables control over the robot in XYZ and 
Joint modes. 

 

Figure 5-5: Robot Movement Dialog Box 

Clicking on an axis image or the XYZPR buttons moves the robot as described 
in the Manual Movement dialog box above. 

To open the Robot Movement dialog box, select View | Robot Movement. 

Teach Positions Dialog Box 

The Simple/Expanded Teach Positions dialog box enables the following: 
• Teaching positions (in Joint coordinates). 
• Recording positions (in Cartesian coordinates). 
• Sending the axes to the recorded positions (when program is not running). 

To display the description of the function of each icon in the Teach Position 
dialog box, simply place the mouse on the desired icon without clicking a 
mouse button.  

The user can define 1000 positions. A higher computer (CPU and memory) can 
hold more positions.  

 

Figure 5-6: Teach Positions Dialog Box (Simple) 
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The Teach Position (Simple) dialog box offers the following options: 
Position Number 1, 2 & Pro A numerical name for position. 

 
Record 1, 2 & Pro Records the current robot position (in joint 

coordinates) to the position displayed in the 
position number field.  

 
Delete  1, 2 & Pro Deletes from memory the position in the position 

number field. 
Expand/Simple 2 & Pro Opens the Teach Positions (Expanded/Simple) 

dialog box.  
Include Axes Pro Instructs the controller to define coordinates for 

Robot, Peripheral axes or both. 

A peripheral position can be recorded only in the 
Pro level. 

Absolute / 
Relative to 

2 & Pro Defines positions either as absolute or relative to 
another position. 

When Relative to is selected, a Relative to field 
appears. Select either an existing position or 
Current. A position that is Relative to Current 
means that the reference position is the robot 
position at the time it is sent to that position. 

 

Go to  
Position 

1, 2 & Pro Executes the Go to Position command. Sends the 
axes to the selected position. 

 

Go Linear  
to Position 

2 & Pro Executes the Go Linear to Position command 
which sends the robot’s TCP (Tool Center Point) 
from its current position to the selected position 
along a linear path (straight line). The linear 
motion applies only to the robot axes.  

Speed 1, 2 & Pro Selects the speed for all movement commands. 10 
fastest, 1 slowest, 5 default. 

Duration Pro Defines the time it takes to complete a movement 
command. The time is defined in tenths of a second. 
For further information, see Chapter 7. 
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Expand  (2 & Pro) 
Click Expand to open the Teach Positions (Expanded) dialog box: 

 
Figure 5-7: Teach Positions Dialog Box (Expand) 

X(mm), Y(mm) 
Z(mm), Pitch (deg.) 
Roll (deg.) 

Fields for displaying or changing the Cartesian 
coordinates of the selected position. 

Get Position Displays the Cartesian coordinates of the selected 
position. 

Clear Clears all position coordinate fields. The position 
data does not change.  

Teach Teaches position using the Cartesian coordinates 
system. 

Go Circular Executes the Go Circular to Position command. 
This command sends the robot in a circular path to 
the target position (in the position number field), 
via the position specified in the Via position field. 

The circular motion applies only to the robot.  
Via position Selects the intermediate position through which 

the Go Circular movement passes. 
Simple Toggles to the Simple Teach Position dialog box.  
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Record Positions (Joint Coordinates) 

Record Absolute Position  
(Levels 1, 2 & Pro) 

To record an absolute position: 

1. Use either the Manual Movement dialog box or the Robot Movement 
dialog box to move the robot to the position you want to record. 

2. Click on the Teach Position dialog box. 
3. Type a Position Number in the Position number field, or select an 

Existing Positions number if you want to modify (overwrite) a 
previously defined position. 

4. Select Absolute. 
5. Select Include Axes (Robot or Peripherals): 

a. Robot: to record a position for the robot axes. 
b. Peripherals: to record a position for the peripheral axes (Pro level 

only). 
c. The user can select both. 

6. To record the current position, click the Record Position icon.  

Record Relative Position (Level Pro) 
To record a relative position: 
1. Make sure you have first defined a reference position. 
2. Move the robot to the position whose coordinates you want to record as 

relative to another position. 
3. In the Position Number field in the Teach Positions (Simple) dialog box, 

enter a new position number. 
4. Select Relative to, and enter a number (or select Current) for the 

reference position in the Relative to field. 
5. Click Record. You have now recorded a relative position. 
A position that is Relative to Current means the specified offset will be 
computed from the location at which the robot is positioned at the time it is sent 
to the relative position. If the reference position changes, the relative position 
also moves. 
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Teaching Positions (XYZ Coordinates) 

In order to teach a position in XYZ coordinates, click Expand. 

Teach Absolute Position (Levels 2 & Pro) 
To teach an absolute XYZ position 

1. Click Expand. 
2. Enter XYZ Pitch and Roll values. 
3. Click Teach. 
To use existing position coordinates to define a new position (or modify that 
position’s coordinates), do the following: 
1. In the Position Number field in the Teach Positions dialog box, select an 

absolute position number. 
2. Click Get Position. The XYZPR values of the position now appear in 

the XYZ Pitch Roll fields. Note: If the position is relative, only the 
offset values will be displayed. 

3. In the Position Number field, enter a different number (or leave the 
position number if you want to modify that position). 

4. To record a position for the robot axes, click Robot. 
To record a position for the peripheral axes, click Peripherals. 
To record positions for both, click Robot and Peripherals. 

5. In one or more of the coordinate fields, enter a new value (in millimeters 
or degrees). 

6. Click Teach. 
Warning:  If you click Record, the current TCP coordinates will be written to 
the selected position. 
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Teach Relative XYZ Position (Levels 2 & Pro) 
To record a relative XYZ position: 

Make sure you have first recorded the reference position.  
1. In the Position Number field, in the Teach Positions dialog box, enter 

the new position number. 
2. Select Relative to, and enter the number of the reference position in the 

Relative to field. All XYZ coordinate fields are blank or show 0. 
3. In one or more of the coordinate fields, enter a new value (in millimeters 

or degrees). 
4. Click Teach. 
A position that is relative to current means the specified offset will be 
computed from wherever the robot is located at the time it is sent to the relative 
position. 

If the reference position changes, the relative position moves accordingly. 

List Positions Window 

List Positions 
The List Positions window displays the positions of the currently open project. 
The list is presented in tabular format. As default, the table presents position 
information in Joint and Cartesian coordinate systems.  

Each row in the table represents a single position. To manipulate the list: 
• Select a position (row). 
• Right-click to display the popup window. 
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Figure 5-8: List Positions with Add Watch Bar on the Bottom 

Position Popup Window 
Position No. The number/row of the position in the list 
Delete Deletes the selected position. 
Delete All Deletes all listed positions from the SCORBASE 

memory. 
Add Watch Moves the position data to the watch list. 
Show Joint Shows only Joint values of all positions. 
Show XYZ Shows only the XYZPR of all positions. 

 

Show Both Shows both Joint and XYZPR values of all 
positions. 

Note: The peripheral positions are always displayed using encoder counts. 
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Dialog Bars 

SCORBASE offers three dialog bars that display all axes encoder counts and 
the robot position in Cartesian (XYZ) coordinates and Joint coordinates. All 
dialog bars are accessible at all levels via the View menu. 

Encoder Counts Dialog Bar 
The Encoder Counts dialog bar displays the current values of the encoders for 
each of the eight axes.  

 

Figure 5-9: Encoder Counts Dialog Bar 

To display the Encoder Counts dialog bar, select View | Dialog Bar | Encoders. 

The encoder values change whenever the axes are moved. 

These values are set to 0 (or close to zero) after the Search Home command is 
executed. 

XYZ Dialog Bar 
The XYZ dialog bar displays the current Cartesian (XYZ PR) values of the 
TCP. 

 
Figure 5-10: XYZ Dialog Bar 

To display the XYZ dialog bar, select View | Dialog Bar | XYZ.  

The values shown in the above example are the Joint values after the Search 
Home command is executed. 

Joints Dialog Bar 
The Joints dialog bar displays the angles between the two links of the joint, in 
degrees. 

 
Figure 5-11: Joints Dialog Bar 

To display the Dialog bar, select View | Dialog Bar | Joints. 

The values shown in the above example are the XYZ values after the Search 
Home command is executed. 
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Using a Teach Pendant with 
SCORBASE 

The Teach Pendant is a hand-help terminal that permits the operator direct 
control of the robot and peripheral axes. In addition to controlling movement of 
the axes, the Teach Pendant may be used for recording positions, sending the 
axes to recorded positions, and other functions. 

To control the axes from the Teach Pendant, SCORBASE must be operating in 
the On-line mode, and the Teach/Manual switch on the Teach Pendant must be 
switched to Teach. This disables control of the axes from SCORBASE dialog 
boxes. 

All Teach Pendant operations are reflected in the SCORBASE dialog boxes. 
For example, positions recorded by the Teach Pendant will appear in the 
Position Number list in the Teach Positions dialog box; and encoder and XYZ 
values will change in the Encoder Counts and XYZ dialog boxes. 

The Teach Pendant operation is described fully in the Teach Pendant for 
Controller User Manual. 
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6 
Program Editing 

A SCORBASE program is a set of instructions written by the user to control 
the robot, peripheral equipment and to communicate with external I/O devices. 
This chapter explains how to create and edit a SCORBASE program. 

The following tools are used for program editing: 
• Program commands editor. 
• Command tree that lists all SCORBASE commands.  

Opening and Closing a Program  

Every SCORBASE program is part of a SCORBASE project. A project also 
includes the user-defined positions, project data and, if RoboCell is installed, a 
virtual cell (3dc file). Only one project can be opened at a time. 

To open a saved program, open the project containing the desired program by 
doing one of the following: 
• Select File | Open Project…  

• Click on the Open an Existing Project icon . 
• Press Ctrl + O. 

In all cases, the Load Project window will open, prompting you to select the 
project that contains the program you want to edit.  

The program is displayed in the Program window. 

To open a new program, open a new project by doing one of the following: 
• Select File | New Project…  

• Click on the Create a new project icon . 
• Press Ctrl + N. 

To activate the dialog boxes that are most useful for program editing, select 
Window | Teach & Edit. The screen layout that appears depends on the 
currently selected SCORBASE level. 
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Figure 6-1: Project Window - Pro Level 

Program Editing Tools 

SCORBASE is a text based programming language in which every command 
is a single text line. SCORBASE programs are edited by means of the usual 
Windows text editing options, which can be accessed: 
• Via the Edit menu 
• By pressing the designated keys 
• By right-clicking the mouse in the program window to open a pop-up 

menu. 
Cut - Ctrl+X Deletes selected text or lines from the program, 

and places it on the Windows and SCORBASE 
clipboards. 

Copy - Ctrl+C Places a copy of selected text or lines from the 
program on the Windows and SCORBASE 
clipboard. 

Paste - Ctrl+V Inserts the contents of the SCORBASE clipboard 
into the program. 

Find - Ctrl+F Opens a dialog box that allows you to search for 
any string, such as a command or text. 
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Find Next - (F3) Repeats the last Find operation for the next 
occurrence. (Accessible also from the Find dialog 
window). 

Command/ 
Remark (*…) 

Inserts/deletes asterisk at beginning of a command 
line. 

SCORBASE ignores command lines that start with 
an asterisk. This feature is useful for debugging. 

Go to Line Opens a dialog box that displays the total number 
of lines in the program and prompts you for a line 
number. Type in the number. The program editor 
will jump to the line you specify. 

 
In addition, use the keyboard for the following functions: 
[Ins] Toggles between Insert and Overwrite modes. The 

active mode is shown in the Status bar. 

When Insert is active, a new command is inserted 
into the program above the line currently marked 
by the cursor. 

[Del] Deletes the line or lines currently marked by the 
cursor. 

[Ctrl+Home] Brings the cursor to the first line of the program. 
[Ctrl+End] Brings the cursor to the last line of the program. 
[PgUp] Displays the previous page of program lines. 
[PgDn] Displays the next page of program lines. 
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Adding and Editing Commands  

SCORBASE commands are organized in a Command Tree.  
• At the Introductory level (Level 1), only basic commands appear in the 

Command Tree. 
• At the Advanced level (Level 2), the number of commands is increased. 
• At the Professional level (Pro Level), all commands are accessible. 

To see the Command Tree, click the Command tab in the Workspace window.  

SCORBASE commands are grouped into these categories: 
• Axis & Control 
• Program Flow 
• Inputs & Outputs 
• Advanced - By default, this category is hidden. Select Options | Advanced 

Options | Advanced Commands to display these commands.  
• Vision - By default, this category is hidden. Select Options | Advanced 

Options | ViewFlex Commands to display these commands.  

Clicking on a category opens/closes the list of commands. 

To add commands to a program, do one of the following: 
• Double-click on the desired command in the Command Tree. 
• Type the two letters written next to the command. 
• Click on the command icons in the Program window (applicable only for 

selected commands).   

If you are working in Insert mode, the new command line is added above the 
currently selected (highlighted) line. If you are working in Overwrite mode, the 
new command replaces the selected line 

Many commands open dialog boxes for completing the command line 
parameters. 

To change a command parameter, click on the command to re-open the 
command dialog box. Change the required parameter, and click OK to close 
the dialog box. Note: For safety reasons, certain parameters are not accessible 
by the user, i.e., they appear grayed, and can be changed only by Intelitek 
support personnel.  

To delete, cut, copy and paste a line, use the usual Windows tools. 
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Axis Control Commands 

 

 

 
Level 1 – Introductory Level 2 – Advanced Pro - Professional 

Figure 6- 2: Command Tree - Axis Control 

Icon Command Levels Description 

 
OG  Open Gripper 1,2,Pro Fully opens the gripper. 

 
CG  Close Gripper 1,2,Pro Fully closes the gripper (on itself, or on a grasped 

object). 

 
GP  Go to Position 1,2,Pro Opens the Go to Position dialog box. The Go to 

Position command sends the robot to a recorded 
position, in the shortest time, using Point to Point (P 
to P) control. In Point to Point control, all axes move 
independently and there is no control over the TCP 
trajectory.  
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Target Position The destination of the movement. 
Enter a number or a variable in this 
field.  

Via Position The position via which the 
destination of the movement is 
reached. Enter a number or a 
variable in this field.  

Movement Control 
Joint Checked if window is opened from 

the Go to Position command. When 
Joint is selected, the robot moves to 
the target position in Point to Point 
control (no control over TCP 
trajectory). 

Linear Check to modify the Go to Position 
command to Go Linear to (available 
only in Levels 2 and Pro). See the 
Go Linear to command for more 
details. 

Circular Check to modify the Go to Position 
command to Go Circular to 
(available only in Levels 2 and Pro). 
See the Go Circular to command for 
more details. 

Speed/Duration 

Fast Executes the movement at the fastest 
speed possible.  

Speed Executes the movement at a slower 
speed. Enter a number from 1 
through 9, or a variable, in the Speed 
field. Default: 5 (average speed). 

Duration Executes the movement in a specific 
amount of time. Enter the time in 
tenths of a second, or a variable. 
Available only in Pro Level. 
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GL   Go Linear to 
Position #_Speed 
... 

2,Pro Sends the robot’s TCP (tool center point) from its 
current position to the target position, along a linear 
path (straight line). The linear motion applies only to 
the robot axes. 

 
GC    Go Circular 
to Position #_ 
Speed... 

2,Pro Sends the robot’s TCP in a circular path to the target 
position, via the position specified in the Via Position 
field.  The circular motion applies only to the robot. 
Note: The Circular command follows the circle that 
blocks the triangle defined by the three positions 
(current TCP position and target position, and the 
intermediate position specified in the Via position 
field). 

 JA    Jaw  Pro Moves the gripper’s jaw to the specified span.  The 
command opens this dialog box: 

 
Enter a number or a variable in the Jaw field. 

Note: Accuracy cannot be guaranteed if the width is 
less than 5 mm or greater than 65 mm. 

Jaw activates Servo Control for the gripper motor, 
whereas Open Gripper and Close Gripper commands 
do not use the gripper axis Servo Control. 

Unless you need the Jaw command for a specific 
application, the Open Gripper and Close Gripper 
commands are recommended. 

Note: This command is applicable for 
SCORBOT ER-4u only. 
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 IL    If Limit Switch 
< # > on jump to 
<Label> 

2,Pro The IL is a conditional jump command. It causes 
program execution to jump to the line that contains 
the specified Label, if the selected axis micro switch is 
pressed (On). The command opens a dialog box. 

 
Enter the Axis number, or a variable in the Limit 
Switch field.  
Enter the name of a Label in the Jump to field. 

 RP Record 
Position #_ 
 

Pro When the Record Position command is executed 
(during program execution), the controller records the 
current position data to the specified position. The 
command opens this dialog box: 

 
Enter a position number or a variable in the Record 
Present Position as Position field.  
The Record Position command is useful when a 
position (and all relative positions that refer to that 
position) must be relocated, during program 
execution. This command updates the position data. 

 SA    Set Axis #_ 
... (to Zero) 

2,Pro Initializes (sets to 0) the encoder count of the selected 
axis. The command opens this dialog box: 

 
Enter a number or a variable in the Axis field. 
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 SC    Start 
Conveyor 
 

Pro Starts the conveyor, as a speed-controlled conveyor. 
Movement of the conveyor will continue until a Stop 
Conveyor (ST) command is encountered. 

The command opens this dialog box: 

 
• Enter the Axis number in the Axis field 

• Enter a number or a variable in the Speed 
field.  

• Select a movement direction (Plus or Minus). 

Note: When operating a speed controlled conveyor by 
means of the Start/Stop Conveyor commands, do not 
record positions, and/or use the Set Axis (to Zero) 
command for the conveyor, in the same program. 

 ST    Stop 
Conveyor 

Pro Stops the continuous motion of a conveyor that was 
initiated by a Start Conveyor command. 

 SV    Set Variable 
to Gripper Sensor 

Pro Assigns the value of the gripper opening (in mm) to a 
variable. This command is useful when there is a need 
to measure the object in the gripper, or to check the 
gripper status (open, closed or gripping an object). 

 

In the Name field, enter the name of the variable. 

For more information on variables, refer to Chapter 7, 
Variable Programming. 

Note: This command is applicable for 
SCORBOT ER-4u only. 
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Program Flow Commands 

 

 

 
Level 1 – Introductory Level 2 – Advanced Pro - Professional 

Figure 6-3: Command Tree - Program Flow branch 

Icon Command Levels Description 

 WT    Wait (10ths 
of second) 

1,2,Pro Halts program execution for a specified time. The 
command opens this dialog box: 

 
Enter a number or a variable in the 1/10 of second 
field. 

 JU    Jump to 
 

1,2,Pro This unconditional jump command causes the 
program pointer to jump to the line that contains the 
specified Label. The command opens this dialog box: 
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Enter the Label name in the Jump to field. (Be sure to 
include a line with this Label in your program.) 
When the Jump command is used, Jump is checked in 
the dialog box. You can modify the Jump command to 
an IF jump command (conditional jumping) only in 
Levels 2 and Pro. 

 RE    Remark 2,Pro Allows insertion of a comment line for explanation 
and documentation into the program. The command 
opens this dialog box: 

 
Enter up to 47 characters of text, including spaces. 

 RB    Ring Bell 2,Pro When executed, this command produces a beep, using 
the computer’s internal loudspeaker. 

 RT    Reset Timer Pro SCORBASE uses a timer that measures time in units 
of tenths of a second. The timer starts operating when 
SCORBASE is opened.  

The Reset Time command resets the value of the 
SCORBASE timer to 0. 

To use the timer, the timer value must be assigned to a 
variable, using the Set Variable command. (See the 
Set Variable command for more details). 

 
SV    Set Variable 
(to Computation) 

2 Allows you to assign a value, or an expression (result 
of a specific computation), to a variable. 

The command opens the Set Variable dialog box  
(Computation is checked). 
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In level 2, the Set Variable value can only be a result 
of computation. In the Pro level, variable values can 
be derived from other sources. For further 
information, see the Set Variable (to Timer, Gripper 
Sensor or Analog Input) command below. 
Name Enter the name of the variable. The 

first character must be a letter. 
Value or 
Expression 

Enter a value or a computation. 

To set the variable to a fixed value, 
enter a number (in the range of 
+/-1000000). 

To set the variable to the result of a 
computation, enter a string that 
consists of two arguments and an 
operator. An argument can be either 
an integer or a variable (e.g., fun*2). 

Click on the arrow to see a list of 
operators, or use the following list:  

Arithmetic Operators 
+ 
* 
- 
/ 
 

Addition 
Multiplication 
Subtraction 
Division 

Algebraic Operators 
% Modulus (returns the remainder of 

the first argument divided by the 
second). 

** Power (raises the first argument to 
the power of the second argument). 
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Logical (Boolean) Operators 
& 
| 
^ 

And 
Or 
Exclusive or 

The result of a logical operation is 1 (True), or 0 
(False). Any operand with a non-zero value is 
considered true, while a zero value is considered false. 

Comparison Operators 
< 
> 
<= 
>= 
<> 

Less than 
Greater than 
Less than or equal to 
Greater than or equal to 
Not equal 

By default, = is assumed to be the operator. You do 
not have to include it in the Value or Expression field. 

Examples: 
Set Variable COUNT = COUNT – 1 
Set Variable C = A * C 
Set Variable DD = DD + 1 
Set Variable POS = P >= 1 
Set Variable V1 = V <> 1 
Set Variable VAR_A = A % 3 
Set Variable M = M ^ 1 
Set Variable R = 3 ** 2 

For more information on variables, see Chapter 7, 
Variable Programming. 

 SV    Set Variable 
(to Timer, Gripper 
Sensor or Analog 
Input) 

Pro Allows you to assign a value, or an expression (result 
of a specific computation), to a variable. 

In Pro level, there are four methods of setting a 
variable value: 
Computation Variable value equals a constant, a 

variable, or a result of algebraic or 
Boolean computation. See the SV 
Set Variable (to Computation) 
command in Program Flow 
Commands above. 
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Gripper sensor Variable value equals the distance 

between jaws (in millimeters). 

See the SV Set Variable to Gripper 
Sensor command in Axis Control 
Commands above. This command is 
useful when there is a need to 
measure the object in the gripper, or 
to check the gripper status (open, 
closed or gripping an object). 

Timer Variable value equals the current 
value of SCORBASE timer. 

The SCORBASE timer starts 
operating when SCORBASE is 
opened. 

To initialize the SCORBASE timer 
in a program, use the Reset Timer 
(RT) command described above. 

Analog input Variable value equals analog input 
value. 

See the AI Set Variable to Analog 
Input # command in Input/Output 
Commands below. 

A value assigned using the SV command can be used 
for conditional jumping using the IF <Condition> 
Jump command. Actions can then be generated 
according to the variable value. The following 
example jumps the program cursor to a label if more 
than three seconds elapse after timer reset: 
Reset Timer 
… 
Set Variable TIME to timer 
IF TIME > 30 jump to PICKUP 

For more information on variables, see Chapter 7, 
Variable Programming. 

 
IF    If Jump to 2,Pro A conditional branch command, which is used to 

determine the program flow in relation to the value of 
the variables. The command opens this dialog box: 
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If the condition in the IF field is true, program 
execution jumps to the line specified by the label in 
the Jump to field. 

If the condition in the IF field is false, program 
execution skips to the following line. 
IF Enter the condition. The condition 

includes a variable name, a 
comparison operator and another 
variable name, or a number. 

Jump to Enter the name of a Label. (Be sure 
to include a line with this Label in 
your program.) 

   Example: 
If COUNTER > 0 jump to START_LOOP 
Go to Position 1 speed 5 
… 
START_LOOP: 
Go to Position 2 speed 5 

If the value of Counter is greater than zero, the robot 
will go to Position #1.  

If the value of Counter is equal to or less than zero, 
the robot will go to Position #2. 

Use two equal signs (= =) for equal operators. For 
example: 
If COUNTER = = 0 jump to END 

The IF jump command can be converted to an 
unconditional jump command by selecting Jump 
(instead of If). 

 SS    Set 
Subroutine 

2,Pro Creates a subroutine. You can program up to 64 
subroutines in one program. The command opens this 
dialog box: 
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In the Name field, enter a name or number for the 
subroutine. 

Note: Create subroutines only at the end of the main 
program. Every subroutine must end with a Return 
from Subroutine command. 

 
 RS    Return from 

Subroutine 
2,Pro Marks the end of a subroutine. At run time, this 

command terminates the execution of the subroutine, 
and the program resumes execution at the line that 
follows the Call Subroutine command. 

Note: Every subroutine must end with a Return from 
Subroutine command. 

 CS    Call 
Subroutine 

2,Pro Activates the specified subroutine. The command 
opens this dialog box: 

 
In the Name field, enter the name of the subroutine. 

Notes: Use the Call subroutine command either from 
the main program or from another subroutine 
command. 

You can call the same subroutines several times from 
a few places in the program. 

After the subroutine is executed, the program resumes 
execution from the line that follows the Call 
subroutine command. 

 LA    Label 1,2,Pro Marks a line in the program that is referenced by a 
Jump command. The command opens this dialog box: 
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In the Label field, enter a name.  

Do not include blank spaces, use an underscore. 

Do not use the same label name more than once. 
 PS    Print to 

Screen & Log 
2,Pro Instructs SCORBASE to print data containing strings, 

messages and variable values to a log file, or to the 
message window, or to both. The command opens this 
dialog box: 

 

Enter text and spaces of up to 47 characters. 

To print a value of a variable, place the variable name 
in single quote marks. For example: VARX='X' will 
print as VARX=50 (when the value of X is 50). 

Click the desired print destination. 
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Input/Output Commands 

 

 
Level 1 & 2 - Introductory & 

Advanced 
Pro - Professional 

Figure 6-4: Command Tree - Inputs & Outputs Branch  

 II    If Input # 
On/Off Jump 

1,2,Pro Causes the program to jump to a label or call a 
subroutine, if the state of the tested digital input 
matches the status specified (On or Off). The 
command opens this dialog box: 

 
In the Input Number field, enter the number of digital 
input (1-8), or a variable. 

Select either On or Off for the state of the input. 

Select either Jump or Call Subroutine; then complete 
the active field. 

In the Jump to field, enter the name of a Label. 

In the Call Subroutine field, enter the name of a 
subroutine, or a variable. 

 OI    On Input 
Interrupt # On/Off 

Pro Sets the condition for an input interrupt service. The 
service (Call Subroutine) will be performed whenever 
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the condition (input status) is satisfied, regardless of 
the current program pointer position. The command 
opens this dialog box: 

 
Input Number Enter the number of a digital input, a 

variable or the word ANY. Use of 
the word ANY causes any input  
(1-8) to evoke the interrupt state. 

On/Off Select the state of the input. 
Call Subroutine Enter the name of a subroutine that 

will be executed in case of interrupt. 

An interrupt command causes the program to halt the 
command it is currently executing (which can also be 
a movement or a delay), and to immediately execute 
the command specified for this interrupt. If the 
specified command is a Call Subroutine, the program 
will resume from the point where it was suspended, as 
soon as the subroutine completes its execution. 

An interrupt command can be disabled and enabled by 
means of the Enable Interrupt and Disable Interrupt 
commands described below. 

Example: 

On Input Interrupt 5, on call sub. SUB5 

When input 5 is turned on, the program immediately 
calls subroutine SUB5. If any axes are moving when 
the interrupt occurs, they will immediately stop. When 
the subroutine is completed (Return from Subroutine 
command is reached), the axes will reassume the 
position and status that were interrupted, and the 
program will continue from that point. 

 DI    Disable 
Interrupt #  
 

Pro Causes the specified input interrupt to become 
inactive. When an interrupt is inactive, it is 
disregarded until the Enable Interrupt command 
reactivates it. The command opens this dialog box: 
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Input Number Enter an input number, a variable, or 

the word ALL. 
Enable/Disable Select Enable in order to modify the 

command. 
 EI    Enable 

Interrupt #  
 

Pro Causes the specified input interrupt to become active. 
The command opens this dialog box: 

 

When an interrupt is active, it is waiting for an 
interrupt status (defined using the On interrupt 
command described above). 
Input Number Enter an input number, a variable, or 

the word ALL. 
Enable/Disable Select Disable in order to modify the 

command. 

 
On    Turn On 
Output # 

1,2,Pro Sets the state of the specified digital output On. The 
command opens this dialog box: 

 

 
Output Number Select a number or type a variable 

name. 

The default settings of Digital and On can be changed  
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OF    Turn Off 
Output # 

1,2,Pro Sets the state of the specified digital output Off. The 
command opens this dialog box: 

 
Output Number Select a number or type a variable 

name. 

The default settings of Digital and Off can be changed 
 AO    Set Analog 

Output # 
Pro Sets the state of the specified analog output. The 

command opens this dialog box: 

 
Output Number Enter a number (1 or 2), or a 

variable. 
Value Range Enter a  number  between 0 and 255 

which corresponds to the output 
voltage. The range of the output 
voltage is 0-10 V.  

The Analog default setting can be changed. 

 

 

 

 
 AI    Set Variable 

to Analog Input # 
Pro Sets the value of the specified analog input to a 

variable. The command opens this dialog box:  
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Name Enter the name of the variable. The 

first character of the name must be a 
letter. 

Analog Input 
Number 

Enter an input number (1-4) or a 
variable, where the variable value is 
an integer in the range of 0-255 
corresponding to a controller input 
voltage of 0-10 volt. 

See also the description of the Set Variable commands 
in the preceding sections of this chapter.  

Advanced Commands 

Advanced Commands are displayed in the Command Tree when you select 
Options | Advanced Options | Advanced Commands. 

 

 

 

Pro - Professional  

Figure 6-5: Command Tree - Advanced Commands 
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 UP    Use 
Parameter Set 

Pro Specifies the Parameter Set to be used. The command 
opens this dialog box:  

 
Open the drop-down list to select the desired 
Parameter Set and click OK. 

See Parameter Set Windows for further information.  
 PV    Set 

Parameter Value 
Pro Sets the value for a selected device parameter by 

name. The command opens this dialog box:  

 

 
Axis Open the drop-down list to select the 

axis for which you need to change 
the parameter.    

Name Open the drop-down list to select the 
parameter whose value needs to be 
changed. 

Value Enter the new value. 

The details of the selected parameter are automatically 
displayed.   
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Vision Commands 

Vision Commands are displayed in the Command Tree when you select 
Options | Advanced Options | ViewFlex Commands. See the ViewFlex User 
Manual for full details. 

 

 

Pro – Professional  

Figure 6-6: Command Tree - Vision Commands 
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7 
Variable Programming 

The SCORBASE language allows variable programming. Variables allow you 
to write commands that change as the state of the robot or its environment 
changes during program execution. Therefore they are useful for creating loops 
and subroutines in robot programs.  

To use a variable, it must first be defined using the Set Variable command (see 
Chapter 6, Program Editing).   

Variable names can be up to 22 characters long. It is recommended, however, 
that you use meaningful names that are as short as possible. The first character 
of the name must be alphabetic. 

In most editing commands, a variable can be specified instead of a numeric 
value.  

A variable cannot be used to specify a Label or a Subroutine. 

If, at run time, the program encounters a variable whose value is not defined or 
is out of range, an error message is displayed. 

 

Figure 7-1: Undefined Variable Error Message 

Using a Variable Instead of a Numeric Value 

Example #1   
Set Variable station1=5 

Set Variable lamp=1 

Go to Position station1 fast 

Turn on output lamp 

In this example, one of the robot stations named “station1” is recorded as 
position #5 and a lamp is connected to output #1. When the program initiates, 
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the value (5) is assigned to the variable named station1 and the value (1) is 
assigned to the variable lamp. The following program lines send the robot to 
position “station1” and turn on a “lamp”. Using a meaningful name for the 
variable makes the programming, debugging and maintenance easier. 

Example #2  
Set variable pos = 0 

Start: 

Set variable pos = pos +1  

Go to position pos fast 

Wait 50 (10ths of seconds) 

If pos < 5 jump to start 

In this example, the robot moves to Pos. #1, #2, #3, #4 and #5. In every 
position the robot waits 50 seconds. After waiting at position #5, the program 
terminates. 

Example #3  
Start: 

Set variable tested = 0 

Loop: 

Set variable tested = tested +1  

If input tested off call sub off 

If input tested on call sub on 

If tested < 8 jump to loop 

Jump to start 

 

Set Subroutine off 

Turn off output tested 

Return from subroutine. 

 

Set Subroutine on 

Turn on output tested 

Return from subroutine 

In this example, the program sequentially scans digital inputs 1 through 8 in an 
endless loop. 

If the tested input is On, the program turns on the corresponding output. 

If the tested input is Off, the program turn the corresponding output off. 
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Monitoring Variable Value 

To monitor a variable value, SCORBASE offers the following tools: 
1. When SCORBASE is running and a Set Variable command is executed, 

the current value of the variable is displayed in the status line at the 
bottom of the screen. 

2. When the program is not running, click on the Set Variable command in 
which the value is assigned to the variable, and then execute this line 
using the Run Single Line command. The variable value is displayed in 
the status line at the bottom of the screen. 

3. The Print to Screen & Log (PS) command can also be used to print the 
actual value of a variable, by placing the variable name within single 
quote marks in the text to be printed. 

Example: 
Set Variable z = 5 

Set Variable x = 9 

Set Variable y = x - z 

Print to screen z=’z’ x=’x’ y=’y’ 

When the program is running, the following messages appear in the status bar: 
1. When the first line is executed, the message is z=5 
2. When the second line is executed, the message is x=9 
3. When the third line is executed, the message is y=4 
4. When the fourth line is executed, this window opens: 
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8 
Program Execution 

The Program window and the dialog bars described in this chapter are used for 
activating and monitoring program execution. 

Select Window | Run Screen to display only the Program window, which 
shows the section of the program currently executed. 
• Status bar - indicates the currently executed line or current value of a 

variable. 
• Dialog bars - show the Analog Input, Analog Output, Digital Input, Digital 

Output values. To activate the dialog bars that are most useful for program 
execution, select View | Dialog Bars and then the desired dialog bar from 
the pop-up menu. 

• Log file - records data during program execution. 

The screen layout depends on the currently loaded level of SCORBASE. 

 

Figure 8-1: Run Screen Pro Level 
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Running a Program 

SCORBASE offers three modes of running a program. To select the running 
mode do one of the following: 
• Click the appropriate Run icon in the toolbar.  
• Select one of the Run options in the Run Menu. 
• Press the function key. 

 
Single line (F6) Runs the currently selected (highlighted) line. 

 
Single cycle (F7) Runs the program from the currently selected 

(highlighted) line. Running stops after the last line 
is executed. 

 
Continuous (F8) Runs the program from the currently selected 

(highlighted) line. After the last line is executed, 
program execution continues from the first line. 

The [Run] key on the Teach pendant cannot be used to start execution of 
SCORBASE programs. 

Note: Always restart execution of a program from the first line after you have 
changed program data (e.g., recorded new coordinates for a position, edited a 
program line, etc.). 

Halting Program Execution 

Stop and Pause are the two methods of halting program execution from 
SCORBASE. 

To stop or pause programs from SCORBASE do one of the following: 
• Click the appropriate icon in the toolbar. 
• Select Run | Stop, or Run | Pause. 
• Press F9 / F10 - Make sure the SCORBASE application is the currently 

active window before you press F9 / F10. 
• To STOP the program you can also press the red EMERGENCY button on 

the controller or press the ABORT key on the Teach Pendant (if installed). 

 
Stop (F9) Program execution is stopped immediately. Use 

this command only in emergencies. 

 
Pause (F10) Stops program execution only after the current 

command has been executed. Thus, axes may 
continue moving (to complete their motion) after 
the Pause command is issued. 
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Digital Inputs & Outputs Dialog Bars 

The Digital Inputs & Outputs dialog bars show the status of the controller 
digital inputs and outputs. The display is available in all modes of operation. 

 

Digital input dialog bar 

 

 

Digital output dialog bar 

In both dialog bars, when the I/O status is Off (false), the matching I/O number 
is dark green. When the I/O status is On (true), the matching I/O number is 
light green  

If control is On, the sixteen Output / Input LEDs on the front panel reflect the 
I/O status. 

If control is On, clicking on an output number in the Digital Output dialog bar 
toggles the status of the controller’s digital outputs. 

In Off-line the Digital Output dialog bar can also be used to simulate the status 
of controller's digital inputs. This option is useful for checking the If 
Input#_onJump command. 

In On-line mode, to test the program response for the If Input#_onJump 
command, short the designated input terminal to the digital input ground.  
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Analog Inputs & Outputs Dialog Bars 

SCORBASE can monitor and control four (4) analog inputs and two (2) analog 
outputs. The Analog Inputs & Outputs dialog bars show the values of the 
controller Analog Inputs and Outputs. 

 

Analog Output 

 

Analog Input 

The Analog Inputs and Output resolution is 8-bit. The Analog Input / Output 
range is from 0 (minimum) to 255 (maximum). 

Output values can only be manipulated when SCORBASE is operating On-
line. To change the value of an Analog Output, do one of the following: 
• Click Output (the color turn from light yellow to white), and type a 

number. 
• Use the AO (Set Analog Output #) command, and run this line. 

When the controller receives an Analog Input signal from an external device, 
the value (0-255) of the signal is reflected in the Input Value field. 
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SCORBASE Log File 

The SCORBASE log file records the messages printed using the PS (Print to 
Screen Log) command. To print to a message to the log file, click either Log 
File or Screen and Log File. 

 

Figure 8-2: Print To Screen Command 

The Log file is initialized (cleared) each time SCORBASE is loaded. 

To see the file content, open the file SCBS.LOG using a text editor (such as 
WordPad). The file is located in the SCORBASE subdirectory named BIN. 

SCORBASE generates a backup file each time the program is closed. 
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9 
Project Files Management 

A SCORBASE project includes the following files: 
• SCORBASE program (file extension *.SBP) 
• Recorded Position files (file extension *.PNT) 
• Project data (file extension *.WS) 
• Graphic image (if RoboCell is installed – file extension 3DC). 

All commands (except for Open) relate only to the SBP, PNT and WS files. 

Opening or saving a project from the File menu opens or saves all project files 
(three or four files).   

As default, all files are located in the Projects directory (folder) in the  
ER 2U or ER 4U directory (depending on which robot is being used for the 
project). 

Project Management 

SCORBASE project files are managed by means of the usual Windows file 
tools, which can be accessed by icons or via the File menu.  

 

New (Ctrl+N) Opens a new, untitled, project named Untitled. 
All project-related files are created. 

 
Open (Ctrl+O) Opens a Load Project File dialog box for 

opening a previously saved project. All project-
related files are opened. 

 
Save (Ctrl+S) Saves the currently active project. If the project 

has not previously been saved (i.e., is untitled), 
a dialog box for specifying the project name 
opens. 

All project-related files are saved. 
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Save As... Opens the Save Project dialog box for saving 
the currently active project under a new name.  
All project-related files are saved under that 
new name. 
As default, all projects are saved in a Projects 
folder. 

Print Program  Prints the program. 
The Program window must be active to select 
this option 

Print Positions Prints the position table. 
The Position window must be open and active 
to select this option. You can open the Position 
window by selecting Window | Project or 
View | List Positions. 

Print 3D image Prints the 3D image (if RoboCell program is 
installed). 

Print Preview  
3D Image 

Opens a dialog window that shows how the 
printed cell will appear on paper. 

Print Charts Opens a dialog box to select the specific axis 
chart for display or printout.  Only one axis can 
be selected at a time. 

Print Preview 
Charts 

Opens a screen, which displays the selected 
axis chart before printout showing how the 
printed cell will appear on paper. 

Import 3D Model Opens the Import 3D Image dialog window 
showing the graphic module files (*.3DC files). 

Edit 3D Model Opens the Graphic Module in CellSetup. 

View File Opens the View File window to display the 
program or position of any selected project. 

Exit Quits SCORBASE. If changes to a program or 
position file have been made, but not yet saved, 
a warning message will be displayed. 

 

 
 



 

User Manual  81 SCORBASE 
0311   System Setup 

10 
System Setup 

SCORBASE offers the following setup options to enable system configuration: 
• Display options. 
• Operation mode and Programming level. 
• Hardware setup. 

Display Options 

The display options enable optimal usage of the screen area. SCORBASE 
offers three basic display options and a wide range of dialog bars and windows 
through which the user can see and change system data. 

Simulation & Teach  
Available only if RoboCell is installed. For further information, see the 
RoboCell User Manual. 
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Teach & Edit 
When a SCORBASE project is opened, the screen is set for the Teach & Edit 
display mode. In this mode, these windows and dialog boxes are displayed: 
• Program window that holds the SCORBASE program. 
• Manual Movement dialog box. 
• Teach Position dialog box. 
• Workspace window that shows: 

• Project data, i.e., positions, user program 
and graphical display 
(if installed). 

• SCORBASE commands tree. 
To open the Teach & Edit layout, select Window | Teach & Edit. 

Run Screen 
The Run Screen display option opens only the program window. When the 
program is running, the currently executed line is highlighted and information 
on the currently executed command is displayed in the status bar. 

Project Screen 
The Project Screen display option holds the Program window, Workspace 
window, and the Position window.  

When the program is running, the currently executed line is highlighted, and 
information on the currently executed command is displayed in the status bar. 

Line Number 
SCORBASE allows you to show/hide the line numbers displayed in the 
Program window. Select Options | Line Numbers. 

By default, program line numbers are displayed. 

Reload Last Project at Start-up 
When SCORBASE is initiated, the program can be set up to automatically 
open the last project. To toggle this option, select/deselect Options | Reload 
Last Project at Startup. A checkmark appearing next to this option indicates 
that the option is on. 
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Additional Display Options 
Joint  Shows angle of the robot joints. 
XYZ Shows position coordinates of the TCP. 
Digital output Shows digital output status and enables toggling an 

output status. 
Digital input Shows the digital input status. Enables toggling an 

input status in Off-line mode, for program debugging. 
Analog output Displays the value (0-255) of Analog output 1 and 2. 

These values can also be modified through this dialog 
bar. 

Analog input Displays the value (0-255) of Analog inputs 1-4. 
Enables setting a value for an input in Off-line mode, 
for program debugging. 

Encoders Shows the eight encoders values. 

All Dialog bars are accessible from the View menu. 

The screen is adjusted to prevent window and dialog bars overlapping. 
Movement 
information 

Displays the following: 
• Position error for all eight axes 
• Home switch status (for all eight axes). The 

number 1 indicates the switch is on (pressed) 
while 0 indicates the switch is off (released). 

• Selected axis (1 – 8) PWM value. The PWM 
value indicates the power sent to the axis 
motor. 

Messages Displays the content of the PS (Print To Screen) 
commands. 

SCORBASE Levels 

SCORBASE offers three programming levels: 
• Introductory (Level 1) 
• Advanced (Level 2) 
• Professional (Pro) 

A higher level offers more commands and tools. Levels can be selected from 
the Tool bar or from the Options menu. 

Display of the Advanced Commands and the Vision Commands is activated by 
selecting Options | Advanced Options. 
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Hardware Setup 

SCORBASE allows you to define the devices that are connected and operated 
by the controller as Axes 7 and 8. The following peripherals can be connected 
to the Controller USB: 
• Rotary Table, 24V Catalog #1009 
• Conveyor Belt (gray), 24V  Catalog #1010 
• 1.0m Linear Slidebase, belt-drive, 24V Catalog #1020 
• 1.8m Linear Slidebase, belt-drive, 24V Catalog #1021 
• Linear Table 0.3m, 24V  Catalog #1013 
• XY-Table, 24V   Catalog #1014 
• Motor Kit 24V  Catalog #1234 

Note: 

The following peripherals are not supported: 
• 1.0m Linear Slidebase, belt-drive, 24V Catalog #1018 
• 1.8m Linear Slidebase, belt-drive, 24V Catalog #1019 

Contact your local distributor for further information 

Do not change the hardware setup unless you are authorized to do so. 

To define the devices, select Options | Hardware Setup.  

The Hardware Setup dialog box opens. 

Click on the arrow to open the list of available devices, and then click on the 
desired device. 
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Appendix A 
The following table describes the command line options that were added to 
version 4.9.1 to enable the integration of user applications with SCORBASE.  

Before operating SCORBASE with these command line options, follow and 
obey all warnings and cautions provided in the user application manuals to 
prevent, for example, hazards from moving parts. 

The SCORBASE command line format that is required when using the options 
described in the table is provided, as follows:   

SCORBASE.EXE [Optional INI File] [Optional Switches] 

  
Option  Description 

/A Determines which system SCORBASE supports, as follows: 

A=[system type] (where system type is 9,4,2). 

/C Closes the SCORBASE application. This command can be 
activated only when SCORBASE is open. 

/D  Determines the SCORBASE projects directory.   

/E Restores the SCORBASE application. This command can be 
activated only when SCORBASE is open. 

/F Opens the SCORBASE workspace file name or new project that can 
be defined by the user, as follows:   

F= [SCORBASE workspace file name] : Opens the specified   
workspace. 

F = [NEW] or [NEWP] : Opens a new project for PRO level. 

F = [NEW2]:Opens a  new project for level 2. 

F = [NEW1]:Opens a new project for level 1. 

/H Performs auto homing from online mode. 
For example, SCORBASE.EXE SCBS.INI /H 

/L Loads a specific workspace in simulation mode.  
For example, SCORBASE.EXE 
SCBS.INI /L=”C:\PROGRAMES\INTELITEK\ 
ROBOCELL\PROJECTS\ER4u\Er4Cell1.WS” 

/M Minimizes the SCORBASE application. This command can be 
activated only when SCORBASE is open. 
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/O Loads SCORBASE in online mode.  
For example, SCORBASE.EXE SCBS.INI /O  

/R Loads a specific workspace and runs SCORBASE.  

For example, SCORBASE.EXE SCBS.INI 
/R=”C:\PROGRAM FILES\INTELITEK\ROBOCELL\ 
PROJECTS\ER4u\Er4Cell1.WS” 

/S Loads SCORBASE in simulation mode. 
For example, SCORBASE.EXE SCBS.INI /S 

/T Displays the SCORBASE application on top of the desktop at 
all times. 

/U Prevents the SCORBASE application from staying on top of 
the desktop. This command can be activated only when 
SCORBASE is open.   

 
Examples of SCORBASE command line procedures are provided, as follows: 

Loading a workspace in simulation mode: 
• At the prompt, type the following: 

SCORBASE.EXE /S /L=”C:\PROGRAM FILES\INTELITEK\ 
ROBOCELL\PROJECTS\ER9u\Act3.WS”. The workspace will be 
loaded in simulation mode.   

Loading the software in online mode and homing the robot:  
• At the prompt, type the following: 

SCORBASE.EXE /O /H /R=”C:\PROGRAM 
FILES\INTELITEK\ROBOCELL\PROJECTS\ER4u\Er4Cell1.WS”. 
The workspace will be loaded in online mode and the robot will be homed. 

 
 


